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Assignment 1
 

Informal note 
 

Sometimes you need to send a message 
that may not be popularly received by its 
recipient.  For the purpose of this lesson, we 
will consider a familiar example.  Let’s say 
you want to tell your roommate to stop 
leaving their dirty dishes around the house.  
You may have already told him/her to stop 
doing this in person, perhaps at first in a 
polite or indirect way, and not unlikely on 
more than one occasion.  You probably 
weren’t surprised, however, to find dirty 
dishes still lying around the house.  

Obviously your message isn’t being heard, 
or it isn’t being remembered.  You might feel 
disrespected, but of course you want to 
avoid expressing those feelings in an ugly 
confrontation with your roommate.  In this 
lesson we will create a simple but effective 
document that boldly and clearly 
communicates your message in a non-
confrontational manner.  You can post this 

document at key areas in your home so that 
your roommate will be reminded to clean up 
every time they see it.   

Be aware, this type of communication can 
be taken as condescending to its target 
audience because it points out their 
shortcomings in a very blunt manner.  It 
does, however, take the burden off of you 
having to remind them over and over, 
although the person reading the message 
will probably be able to guess who posted it 
and react accordingly.  Don’t be surprised if 
you find your document crumpled up and 
thrown in the garbage.  Keep in mind that if 
the reader reacts to your document, it 
means they got the message.   

Feel free to customize the message in this 
note to fit your own personal needs.  
Remember to relax and have fun with this 
assignment.  
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Open Microsoft Word 2010 
 
Open Microsoft Word 2010.  Before you do anything else, find the Quick access toolbar 
in the top left-hand corner of the screen. You can see it has the Save, Undo, and Redo 
tools on it.  These tools, most especially the Save and Undo tools, will be your best 
friends in Microsoft Word.   
 

 
Figure 1-1 – The Quick Access Toolbar 
 
 
 

Save The File 
 

  Click Save and save your file as “Assignment 1”.  You will lose work at one 
point or another because you didn’t save it, but you can minimize your losses by saving 
early and often during the course of a project.  Save, save, save.  It doesn’t cost you a 
dime.   
 

 
 
Figure 1-2 – Saving the file as “Assignment 1” 
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The Undo Tool 
 

  The Undo tool is your other best friend.  You can select the undo tool from the 
Quick Access toolbar, or you can hold CTRL and press Z (CTRL+Z) on the keyboard to 
execute the Undo command.  The Undo command will literally undo just about any 
action you take in Microsoft Word.  If you mess up, get lost, or otherwise feel the need 
to rewind your actions, just use the undo command.  You can undo more than just one 
action.  In some cases you can undo multiple times eventually undoing all of your 
actions, bringing you all the way back to a blank document.   
 
 
 

The Ribbon 
 
All tools and commands in Word can be found on the Ribbon.  You can use the tabs to 
switch between different selections of tools.  You can access some tools by right-
clicking in the work area.  The bottom left-hand corner of the screen shows the number 
of words and pages in your document.  You can change the Document View and the 
Zoom in the bottom right-hand corner of the screen.   
 

 
Figure 1-3 – The Ribbon 
  

  
Figure 1-4 – Pages and Word Count Figure 1-5 – Views and Zoom Control 
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Typing  
 
Click on the blank page shown document window.  You will notice that your mouse 
turns into a cursor when you hover over an area that accepts text.  You should also see 
a flashing line, called the insertion point, which denotes where text will appear when you 
type on your keyboard.  Let’s type our first word:  Attention.  Hit the spacebar on your 
keyboard after typing the last letter n and you will see the “a” become capitalized.  This 
is a feature of Autocorrect.  We’ll work more with Autocorrect later.  
 

 
Figure 1-6 – Your First Word 
 
 
 

Formatting 
 
Creating a document requires two main tasks:  importing the content of the document 
and formatting the content.  Importing content covers typing or copying and pasting 
words (also known as copy) into the document, as well as inserting pictures and other 
graphic elements.  Formatting involves styling all aspects of the document.  In some 
cases, it will be easier to import all of the content before doing any formatting.  In other 
cases formatting the copy and other content as you go can help you find inspiration for 
writing or importing other content. Let’s try some easy formatting first before writing 
more of our note.   
 
We want to make this word stand out so it 
grabs the attention of anyone who sees it.  
We will use tools on the Font and 
Paragraph panels under the Home tab to 
do so.   First you must select the copy that 
you want to format.  You can click and 
drag the cursor across the word so that it 
is highlighted, or you can double-click the 
word to select it.  When something is 
selected, any changes you make will only 
apply to the content that is selected—in 
this case, the word Attention.    
  
 Figure 1-7 – Selecting the Word 
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Let’s place the word in the middle of the 
page by selecting the Center alignment 
option from the Paragraph panel.  Now the 
word appears in the middle of the page.   

  
 Figure 1-8 – Center Alignment 
 
On the Font panel, select the Font drop 
menu to select a new font for the word.  
The default font should be Calibri.  
Instead, select Arial Black from the list.  
The word Attention should now appear in 
the Arial Black font.  You can type the 
name of the font you want in the font menu 
to find it from the list faster.   
  
 Figure 1-9 – Arial Black 
 
Change the Font size to 48 by selecting 
the drop menu with the number “11” (that 
is the default font size in Word 2010).  You 
can also type the font size number in its 
drop menu if you prefer.   
  
 Figure 1-10 – Font Size 48 
 
Now the word is large, but we can make it 
stand out even more.  It should still be 
highlighted, so you can make some 
additional formatting changes to it.  Let’s 
underline the word by selecting the 
Underline tool from the Font panel.  You 
can also hold CTRL and hit U on the 
keyboard (CTRL+U) to toggle underline on 
and off. 

 
Figure 1-11 – Underline 
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Change the color of the text by choosing a 
color from the Font Color option on the 
Font Panel.  Select the downward-facing 
triangle to open a palette of colors.  The 
color red will draw attention to your note.   

  
 Figure 1-12 – Select Red Font Color 
  
Finally, change the case of the letters in 
the word to uppercase by choosing 
UPPERCASE from the Change Case tool 
on the Font panel.   

  
 Figure 1-13 – UPPERCASE 
  

  
Figure 1-14 – The Formatted Title 
  
Now your note’s title commands a great deal of attention.   You are done formatting the 
title.  Notice that the styling of the title may help you feel more ready to write the note:  
now that you’ve got the reader’s attention, what would you like to say? 
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More Formatting 
 
Use the mouse to place the cursor at the very end of the title and then hit ENTER on the 
keyboard.  Hitting ENTER twice will add an empty line as a space and then start a new 
line of text on your document.  However, if you begin typing right away, you will notice 
that the copy has the same styling as your title:  font size 48, red, and underlined.  The 
UPPERCASE option does not carry over.  You can toggle uppercase or lowercase text 
by hitting the Caps Lock button on your keyboard.   
 
You will want to change the font size to 20 on the Font panel, change the Font Color 
back to black (labeled as Automatic at the very top of the color palette, and toggle 
underline off.  You will see the button on the Font panel turn off.  Also, change the 
alignment of the note back to the left by selecting the Align Text Left option on the 
Paragraph panel. 
 

 
Figure 1-15 – Text Formatted for Message 
 
 
 

SAVE YOUR WORK 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
 
 
 

Typing the Message 
 
Now you are ready to type your message.  Hit ENTER to start a new line of text.  This 
will creates some space between the headline and the message.  Start by stating 
clearly what you want the reader to do.  Use the spacebar to type two spaces after the 
end of each sentence.  Then give simple, clear, and rational reasons why you want 
them to do so.  Finish by politely suggesting how the reader can improve their behavior.  
Make your note short and concise.  Remember the KISS rule:  Keep It Super Simple.   
 
If you see any words on your screen that are underlined in a red zigzagged line, Word 
thinks that they are misspelled.  Correct the spelling by using the mouse the place the 
cursor on the word and using the backspace button on the keyboard to erase your 
mistakes and then retype the word.  You can also left-click on the word and select the 
correct spelling from a list of words that Word thinks you are trying to spell.  Word 
underlines words with a green zigzagged line that it thinks have grammar errors.  You 
can correct these errors in the same way.   
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Figure 1-16 – Correcting a Spelling 
Error 

Figure 1-17 – Correcting a Grammar 
Error 

 
When you are finished typing your note, hit ENTER twice.  This will start two new lines 
of text.  You are not going to type on the first new line you created.  That will act as a 
space on the page.  On the second new line, type the words “Thank You.” 
 

 
Figure 1-18 – The Message 
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The main portion of copy in a document is often called the Body.  You will usually not 
want to do too much formatting to the body copy of your documents.  This is because 
excessive formatting of the body copy will distract the reader of your document from 
digesting all of the words in it and comprehending the message you are trying to 
communicate.  However, you may find that the Bold, Underline, and Italic tools on the 
Font panel can help to emphasize important words, phrases, or concepts in your body 
copy.  In the case of the example you can see below, I underlined and italicized what I 
believed to be the most important parts of the note.  The bold tool did not change the 
appearance of the Arial Black font.  If it had I may have used it as well. 
 

 
Figure 1-19 – Underlining and Italicizing important parts of the message 
 
 
 

SAVE YOUR WORK 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
 
 
 

Final Formatting:  Alignment and Case 
 
Your note is almost finished.  The last bit of formatting you need to do involves aligning 
the body copy.  You aligned the title of your note to the center of the page using the 
Center alignment option on the Paragraph panel.  Right now your body copy is aligned 
Left, the default option in Word.  Click and drag the cursor over the words “Thank You” 
to select the entire line of text and then select the Align Right option from the Paragraph 
panel.   
 

 

  
Figure 1-20 – Align Right Figure 1-21 – Thank You Aligned to the 

Right 
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Now triple-click one of the words in the main portion of the body copy to highlight the 
entire paragraph.  You can use the triple-click to select entire paragraphs at a time.  
While the main portion of the body is highlighted, select the Justify option from the 
Paragraph panel.  If you hold your cursor still over the Justify icon on the Paragraph 
panel, you will see that the name of the tool appears along with a keyboard shortcut and 
a description of the tool.  The Justify tool is described as “Align text to both the left and 
right margins, adding extra space between words as necessary.  This creates a clean 
look along the left and right sides of the page.”  You have probably seen text aligned 
this way in a magazine or newspaper.  It is easier to read lines of text equal in length 
that begin and end at the same place.  Justify will often be the preferred alignment 
choice for body copy.   
  

 
  
Figure 1-22 – Justify Figure 1-23 – UPPERCASE 
  
You may also want to change the case of the body copy while you still have it selected.  
Use the Change Case tool on the Font panel and choose UPPERCASE. 
 
Finally, select the View tab on the ribbon and select the 100% tool from the Zoom panel.  
This will resize the document on your screen so that it is the same size as it will appear 
when you print it on the default paper size of 8½” by 11”.  Review your document once 
more, and then save it a final time.  Now you are ready to print. 
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Figure 1-24 – The Finished Note 

 
 
 

SAVE YOUR WORK 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
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Print 
 
Select the File tab and then choose the Print option from the left side of the screen.  
You will see a preview of the document on the right side of the screen.  On the left side, 
select the printer you want to use and the number of copies that you’d like to print, and 
then hit the Print button.  We will go over the other print settings another time.   

 

 

Figure 1-25 – Printing the Note 
 

Congratulations!  You have finished assignment #1.  Thank you so much for your hard 
work.  You can use the file you have saved to create new notes in the future by opening 
the file and editing the copy.  You have already configured the formatting. 

 
 
 

* World Class CAD Challenge 30-01 * - Create an informal note, save and print the 
document in less than 30 minutes.  Continue this drill four times, each time 
completing the note in less than 30 minutes to maintain your World Class 
ranking.  
 


